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The Scenario
Dr. Glen Parker, D.V.M has just graduated from veterinary college and is opening a veteri-

nary clinic in Otter Creek, Wisconsin. The clinic will specialize in companion animal services
such as services for dogs, cats, rabbits, ferrets, hamsters, gerbils, birds, and exotics. No large ani-
mals such as horses or cows will be serviced. The critical information for the office is as follows:

Parker Animal Clinic

9003 Jackson Boulevard

Otter Creek, WI 54999

Phone: 920-555-6886

Fax: 920-555-8713

E-mail: Dr.Glen@parkeranimalclinic.com

LESSON 10

REVIEW AND PRACTICE

OBJECTIVES
Upon completion of this lesson, you should be able to:

■ Fill in the Personal Information.

■ Design a logo.

■ Design an advertisement.

■ Design a letterhead.

■ Design a price list using a table.

■ Design a business card.

■ Design a flyer.

■ Design a postcard.

■ Create labels.

■ Design a brochure.

■ Design a newsletter.

■ Design a Web site.

Estimated time: 4 hours
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Since you are skilled in using Microsoft Publisher to prepare miscellaneous kinds of publica-
tions as well as using other office software, and you have terrific soft skills, you have been hired
as office manager for the clinic. The desktop publishing work will be divided into projects. No
specific instructions are included for the projects. You will be shown a possible solution for a job,
but you should use your design skills when creating these publications. Try to use a certain
“theme” throughout the projects to convey some consistency in design in the publications so cus-
tomers grow accustomed to seeing certain objects that remind them of the clinic. Review the
design tips presented at the beginning of the previous lessons to help you with your designing
tasks. If prerecorded files are to be used, the names of those files will be listed. Print each of the
completed projects, unless otherwise stated.

Job 1- Personal Information
Up to four sets of personal information about a person and/or organization can be saved in

Publisher. These four sets of personal information include Primary business, Secondary Business,
Other Organization, and Home/Family. The set that is selected is the one that determines what
information is displayed. Each piece of information in each set is referred to as a component.
These components will vary depending on which set you choose. The primary business set
includes a personal name, job title, organization name, address, tag line, phone/fax/e-mail, logo,
and color scheme. To initially enter the personal information, you must either start a wizard,
which automatically opens the Personal Information dialog box, or you must choose Personal
Information from the Edit menu. Personal information text can be inserted into a publication at
any time by selecting Personal Information from the Insert menu and choosing the desired com-
ponent. Each component you insert will be in its own text box. 

Up to this point you have been instructed to cancel the Personal Information dialog box
whenever it appeared when you started your publications using a wizard, because you have been
doing projects for various organizations. Now that you are going to be creating publications for
only one organization, you will use this feature. 

S TEP-BY-STEP 10.1
1. Start a blank publication.

2. From the Edit menu, choose Personal Information.
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STEP-BY-STEP 10.1 Continued

3. Key the information shown in Figure 10-1. Click Update.

FIGURE 10-1
Personal Information Dialog Box

4. Try the components by choosing Personal Information from the Insert menu.

5. Select Personal Name. Did Dr. Parker’s name appear in a text box frame? Delete the frame.

6. From the File menu, choose New. Choose any Quick Publication from the Start from a design task
pane. Notice that the personal information appears in several text box frames.

7. Close the publication without saving it. Continue with Job 2.
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Job 2 - Logo
Dr. Parker has asked you to submit possible logo designs from which he may choose for the

Parker Animal Clinic. Use any of the clip art resources available to you to design two or three
logos that might be appropriate for a veterinary clinic. You will group the objects that make up
your logo and save the grouped object as a .jpg file so that you can use the object in the rest of
your publications. You may have to refer back to Lesson 4 to review how to do this. Some require-
ments for you to meet regarding the design of the logo appear in Step-by-Step 10.2. Figure 10-2
shows you a sample logo.

FIGURE 10-2
Sample Logo

S TEP-BY-STEP 10.2
1. Create a blank publication.

2. The logo does not have to contain the name of the clinic.

3. It should measure no more than 2 inches wide and 2 inches tall.

4. Group all objects into one object.

5. Save the object as a .jpg file (xxxJob10-2.jpg with your initials in place of xxx) and print it.

6. Do not save the Publisher file.



2 7 7Lesson  10 Review and Practice

Job 3 - Advertisement
Dr. Parker would like you to create an advertisement for the local newspaper. The size of the

ad should be five inches square. Figure 10-3 shows the information to be included in the ad and
a possible format. Use your design skills to design an ad that is more attractive than the one in
Figure 10-3. Since Dr. Parker likes all of the Clinic logos you created, you get to choose your
favorite. While you are creating the advertisement, you will save your chosen logo in the personal
information set to use in future publications. Then you’ll add it to your advertisement to famil-
iarize potential customers with the logo.

FIGURE 10-3
Sample Ad Copy for Job 3

S TEP-BY-STEP 10.3
1. Create a blank publication with page dimensions of 5 inches wide by 5 inches tall.

2. Set all four margins to 0 inches.

3. Use the Personal Information feature to insert the name of the clinic, the doctor’s name, address,
and phone. 

4. Include the hours (M, W, Th F 8 a.m. to 6 p.m.; Tu 8 a.m. to 8 p.m.; Sat. 8 to 11 a.m.)

5. Include the following text: A full-service medical and surgical facility.
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STEP-BY-STEP 10.3 Continued

6. Save the file as xxxJob10-3. Keep the file open.

7. From the Insert menu, choose Personal Information.

8. Choose Logo. A default picture will appear.

9. Click the wizard button that appears below the default picture. This opens the Logo Designs task
pane. (See Figure 10-4.)

FIGURE 10-4
Logo Designs Task Pane

10. Click Logo Options and then click Inserted picture. This inserts another possible logo from the
Design Gallery.

11. Click Choose picture and locate the logo you just saved in Job 2.

12. Click Insert. The logo replaces the sample one just inserted. You might need to resize it when you
use it in a publication. 

13. Click Save. You will get a prompt that reads as follows: “You have modified the logo to this publica-
tion. Do you want to save the new logo to the Primary business personal information set?” Click Yes.

14. Print xxxJob10-3 and close it.
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Job 4 - Letterhead
Since he frequently sends letters to distributors of equipment and supplies as well as the occa-

sional letter to clients, Dr. Parker has decided that he needs an attractive letterhead. Figure 10-5
shows you a sample design.

FIGURE 10-5
Sample Letterhead Solution

S TEP-BY-STEP 10.4
1. Create a blank publication that is letter size.

2. Using a design of your choice, use the Personal Information feature to insert the following information:
Dr. Parker’s name and title.
The name and address of the clinic.
The telephone number and fax number.
Company logo.

3. Save the file as xxxJob10-4 and print the file.
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Job 5 - Price List
Customers have been having difficulty remembering the prices quoted for services often

needed for cats and dogs. Dr. Parker has asked you to prepare a price list for dog and cat services.
Figure 10-6 shows a sample price list.

FIGURE 10-6
Fee Information for Job 5

S TEP-BY-STEP 10.5
1. Use the letterhead you prepared in Job 4 for the price list. Create a text box frame near the top of

the page.

2. Insert the text file Para.rtf, which is found in your data files, as the introductory paragraph.

3. Using a design of your choice, include the information in Figure 10-6 for pricing. The design of the
table does not have to match Figure 10-6. Note: The graphic with the row of paw prints illustrated in
Figure 10-8 is named pawtracks.gif and is stored in the data files should you want to use it for any
of the jobs.

4. Save the file as xxxJob10-5 and print the file.
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Job 6 - Business Card 
Dr. Parker tells you that he would like business cards created that he can hand out to clients

at the clinic as well as distribute to colleagues or customers when he is conducting business out-
side the office or attending various business functions. A business card is a publication that
includes a person’s name, title, company, business address, phone numbers, e-mail, and possibly,
Web site address. It is generally 31⁄3 inches wide and 2 inches tall and is printed on special stock
paper that is heavier than bond paper. You have not created business cards before, but you
should not have any problem with this task since you have already created so many publications
using a wizard! Figure 10-7 shows you a sample design.

FIGURE 10-7
Sample Business Card

S TEP-BY-STEP 10.6
1. Create a new publication choosing Business Cards in the Start from a design list.

2. Choose a design.

3. Because you are using a wizard, the personal information should automatically be filled in. Make any
other design changes you feel are necessary.

4. Save the file as xxxJob10-6 and print the file.
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Job 7 - Flyer
The members of the staff at the Parkway Animal Clinic have decided to hold an open house

to meet potential clients. You have agreed to put up flyers all around town to advertise the open
house. Figure 10-8 illustrates a sample design.

FIGURE 10-8
Sample Flyer Design

S TEP-BY-STEP 10.7
1. The flyer should be 81⁄2 � 11 inches.

2. The date will be Saturday, September 13, 2003 from 10 a.m. to 4 p.m. 

3. Use the Personal Information feature to insert the name and address of the clinic.
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STEP-BY-STEP 10.7 Continued

4. Try to think of activities that would draw people into the open house. You may use the activities illus-
trated in Figure 10-8 if you can’t think of any activities of your own.

5. Save the file as xxxJob10-7 and print the file.

Job 8 - Postcard 
The owner of a kennel near the clinic has provided you with a lengthy list of customers who

frequent the kennel. Dr. Parker has decided that in addition to the flyers you are posting around
town, it would be good to do some direct mail advertising for the open house. Figure 10-9 illus-
trates a sample design.

FIGURE 10-9
Sample Postcard

S TEP-BY-STEP 10.8
1. Either use the postcard wizard or set up a blank publication as a postcard size.

2. Set the side margins to 0.5 inch each.

3. Include the important information from the flyer on the front side of the postcard.

4. Save the file as xxxJob10-8. Print the file.
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Job 9 - Mailing Labels
You will prepare address labels for the postcards you prepared in Job 8. The client list that

you received from the nearby kennel is complete except for Dr. Parker’s three customers who are
listed in Table 10-1. 

S TEP-BY-STEP 10.9
1. Start the Mail Merge procedure following the same procedure you used in Lesson 8.

2. Follow the normal procedure to begin with a stored list using the file Client list.mdb, which is in the
data files.

3. When your client list appears, look at the information provided about the owners and their pets. Note
that the last two fields contain an “x” for pets that receive grooming or boarding services at the
Parker Animal Clinic. 

4. Then position the highlight on the first entry. Choose Edit, choose New Entry, and add the cus-
tomers in Table 10-1. Add your own record to the list, including a pet of your choice. Click OK. 

5. Use Avery Label 5160 for the main document. Use only the first six fields in the label.

6. Save the file as xxxJob10-9 and print all of the labels.

TABLE 10-1
New Customers for Mailing List

First Name Sylvester Tigger Lu-yin

Last Name Katz Woodland Sheng

Address Line 1 983 Byrd Street 8231 Honey Street 74-B Otter Creek Avenue

City Otter Creek Otter Creek Otter Creek

State WI WI WI

ZIP Code 54999 54999 54999

Home Phone (920) 555-2176 (920) 555-3013 (920) 555-3003

Pet type Canary poodle pug

Birth date 8-99 5-96 4-97

Grooming x x

Boarding x
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Job 10 - Brochure
Create a trifold brochure for distribution to the customers of Parkway Animal Clinic. Be

sure to use ruler guides to preserve the gutter space as you learned in Lesson 5. Figures 10-10 and
10-11 illustrate sample designs.

FIGURE 10-10
Sample Brochure Page 1

FIGURE 10-11
Sample Brochure Page 2

Panel 1 Panel 2 Panel 3

Panel 1 Panel 2 Panel 3
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S TEP-BY-STEP 10.10
1. Include the following information about the clinic.

2. Page 1, Panel 1: This panel should contain invitation information. At the top of the panel, insert
meet.doc and format the four items with bullets. At the bottom of the panel, create a coupon with a
dashed border. The information for the coupon is stored in the data file folder as coupon.doc.

3. Panel 2: The only thing on this panel is the clinic return address in the lower-left corner. Rotate the
text so it looks like the return address on an envelope. If Dr. Parker decides to mail brochures, the
label will be affixed on this panel.

4. Panel 3: This is the cover of the brochure. In addition to the name of the clinic, the information in
front.doc as well as the clinic logo should be included.

5. Page 2, Panel 1: Prices for kitten services. The text is stored as Kitten Services.doc in the data file
folder. Arrange the text attractively and include a clip-art image of a cat or kitten of your choice.

6. Panel 2: Prices for puppy services. The text is stored as Puppy Services.doc in the data files. Again,
include a clip-art image of a dog or puppy on the panel.

7. Panel 3: General clinic information. The text is stored as panel 3.doc in the data files. Make it pretty.

8. Save the file as xxxJob10-10 and print and fold the brochure. Make sure no information falls into the
folds between the panels. If it does, move the text objects out of the fold. Make sure the text objects
are centered within each panel. 

Job 11 - Newsletter
Dr. Parker would like you to create a four-page newsletter that can be handed out at the

open house in September. He has written several articles that you can use along with some paid
advertisements from which you can choose. Make sure you have ample white space on your
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pages and be sure to intersperse graphics and/or small stories/ads to prevent having too much
gray (text) on a page. Be sure to leave enough gutter space between columns. Figure 10-12 illus-
trates a sample design for the first page.

FIGURE 10-12
Sample Newsletter Page 1

S TEP-BY-STEP 10.11
1. Create a blank publication that contains four pages.

2. Set up the number of columns you feel are necessary either on the master page or on each page
individually.

3. You decide on the name of the newsletter.

4. Include a table of contents on the first page as well as the name and address and phone numbers of
the clinic along with Dr. Parker’s name and e-mail address somewhere on the first page. (Use the
Personal Information feature to insert this information.)
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STEP-BY-STEP 10.11 Continued

5. Include a header on pages 2, 3, and 4 that contains the name of the newsletter, the date, and the
page number. These should appear on the master page, but should be ignored on page 1. (See
Figure 10-13 for a sample.)

FIGURE 10-13
Sample Header for Newsletter

6. To provide consistency, you should create a text style for the article titles.

7. You choose which text files to use from the following list of data files. You DO NOT have to use them all.
Alzheimer’s Disease
Chiropractic
Commandments for a Cat
Dental Diseases in Pets
Digestive Problems
Dog Fact (small article)
Dog Quiz
Even Cats Can have Colds and Sniffles (small article) 
Geriatric Dog Care
How to Make Your Dog Happy (small article)
Otter Creek Pet Sitters (small ad)
Pet Allergies
Training Ad (small ad)
Tubby Tabby

8. Make sure that any text box frames that contain articles that continue from one page to another
contain the continuation statements that can be turned on in the Format Text Box dialog box.

9. You choose which, if any, graphics you want to include.

10. Save the file as xxxJob10-11 and print the file.
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Job 12 - Web Site 
Your last job is to create a Web site for Parker Animal Clinic. Dr. Parker would like to start

with three pages. The first page will be your home page, the second page will list the services and
hours, and the third page will list health tips that can be changed from time to time. Add any
graphics you think will add meaning to the information. You might even search for some ani-
mated graphics! Figure 10-14 shows a sample home page.

FIGURE10-14
Sample Home Page

S TEP-BY-STEP 10.12
1. Set up the Web site to contain three pages that are set up to the SVGA page size. Choose a suitable

background and apply it to all three pages.

2. On the home page, include the following information:
Name of the clinic
Name of the owner
Address
Phone and fax numbers
E-mail contact
Company logo
Company slogan: A full-service medical and surgical facility
Hyperlinks to Our Services page and Health Tips page
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STEP-BY-STEP 10.12 Continued

3. Make sure when you create the hyperlinks between the three pages that you change the titles of the
Web pages in the Insert Hyperlink dialog box as shown in Figure 10-15.

FIGURE 10-15
Insert Hyperlink Dialog Box

4. On the second page (Our Services), include the following information:
Name of the clinic
Subtitle: Our Services
Animated dog clip art
Inserted text file: Parker Animal Clinic Services
Hyperlinks to the Home page and Health Tips page.

5. On the third page (Health Tips), include the following information:
Name of the clinic
Subtitle: Health Tips
Animated cat clip art (HINT: You may have to look online for one of these)
Inserted text file: Parker Animal Health Tips
Hyperlinks to the Home page and Our Services page.

6. Save the file as xxxJob10-12 and test the links. Show the finished Web site to your instructor.

Job Well Done
You did it! You completed the review. You should feel much more familiar with the features

of Microsoft Publisher as a result of completing these projects. Ask your instructor about putting
these twelve projects in a portfolio to show prospective employers. 
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SUMMARY

Ιn this lesson, you reviewed and practiced:

■ Filling in Personal Information and using that stored information.

■ Designing a logo and saving it as a picture to use in various publications.

■ Designing an advertisement.

■ Designing a letterhead to be used for future correspondence.

■ Designing a price list using a table.

■ Designing a business card using the Business Card wizard and editing the Personal
Information where needed.

■ Designing a flyer.

■ Designing a postcard based on the information used in the flyer.

■ Creating labels using the Mail Merge feature.

■ Designing a six-panel brochure.

■ Designing a four-page newsletter, using the background feature and connecting text box
frames where needed.

■ Designing a three-page Web site containing hyperlinks linking the three pages.




